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Dear Friends,
Finally, Windows! (Insert cork-
popping sound here)
Thanks for all your congratula-
tion notes about our new
Windows 95/98 quilt design
software Electric Quilt 4. We’re
delighted by the response to
the program, and welcome all
of you who are new users. We
hope you enjoy this issue of
our newsletter, published
about twice a year.

EQ4 Simplified  - Ready Now
We plan on publishing a series of books to help you
get the most out of EQ4. Our first book, EQ4
Simplified , is ready now. Author Fran Iverson
Gonzalez has written this “beginner’s guide” from a
quilter’s viewpoint. You learn visually, designing
specific quilt styles on the computer, as she gently
introduces you to more advanced EQ4 features.
See some of her clever quilt designs in this news-
letter. See them all, along with actual sample book
pages, on her Web site.

EQ4 Block Book  - Ready Now
The EQ4 Block Book , a picture book showing
each of the 2200 blocks in the EQ4 Block Library,
will be ready May 15. This look-up guide makes it
easy for you to locate the block you want to use
without having to scroll through the library files.

Barb Vlack  - Will Be Back!
Get ready. EQ4 expert Barb Vlack, popular author
of Too Much Fun!  for EQ3, will have a new EQ4
book set for winter release. Barb’s book will contain
design recipes, so she’s laughingly suggested
“Barb-EQ Recipes ” as a working title. She’s
cooking up detailed EQ4 instructions for designing
pieced sashes, wreaths, applique blocks and over
50 other tidbits. She’ll also have special instructions
for all you quilting teachers who need class print-
outs.

EQ4 Designer Fabric “Stash” on
CD
Your appetite for fabric is endless! You’re already
asking for more designer fabrics. So watch our Web
site for an announcement of fabric CDs - all new
designer fabrics to use in EQ4. These new scanned
swatches of real fabric will be additions to the 700+
real fabrics already in EQ4.

BlockBase for Windows 95/98
We plan to republish our BlockBase software in a
Windows 95/98 version around year-end. The DOS
version of BlockBase, which has 3500 traditional
pieced blocks, based on Barbara Brackman’s
wonderful block identification book, Encyclopedia of
Pieced Quilt Patterns, is sold out. Registered users
will receive information about the new program.

What Else is New?
We have new programs in the planning stages, and
a new Web site in the works, to allow on-line
shopping. All this is possible because of the help
we’re getting from some great new staff members:
Bill Clifford (scan man and Web wizard) and Sharon
Chase (helpful customer service and order taker).

ClubEQ
Thanks to Barb Vlack & Pat Tribbey, all EQ users
now have a club and gallery exhibition space. See
the article on clubeq (page 3) and visit to see some
amazing quilts by fellow EQ users.

Keep in touch. And thanks for your help and
wonderful support!

Sincerely,
Dean, Penny, Ann, Lu, Margaret, Amy, Jan,
Diane, Bill, Sharon and EQ the Mouse
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Fran Gonzalez Writes New Book
EQ4 Simplified: A beginner’s companion to

Electric Quilt 4 software

Learn EQ4 while creating six
original quilt designs made
just for you by designer Fran
Iverson Gonzalez. No dull
tech stuff here! Fran’s easy
lessons start with the basics
in Part I. She gradually
introduces more advanced
work with layers,
borders, quilting
stitches, the

Wreathmaker, applique drawing,
Country Set, and using the graph
pad, in Part II. All lesson steps, tools
and screens, are illustrated in large
pictures that won’t require you to put
on your glasses. There’s a detailed
Table of Contents as well as a full
Index for quick look-up. Fran Iverson
Gonzalez is an EQ whiz. She’s written two
earlier tutorials, EQ2 Simplified and EQ3
Simplified, and taught beginners’ hands-on EQ
classes at Oklahoma Quiltworks (Oklahoma
City) for years. She uses EQ to create her own
pattern line, including the wonderful “Sky
Lights” EQ Mystery Quilt featured on EQ’s

Web site. Fran’s love of quilts and fabrics,
clear in her book, is rooted in her childhood.
“At an early age I was exposed to vibrant
colors, exotic fabrics, and unusual designs,”
she says. “For relaxation, my grandmother
made very sophisticated and elaborate Mardi
Gras costumes and entire wedding ensembles
on her 1930’s Singer sewing machine. One of

my earliest memories is of collecting
glittering rainbows of elegant, se-
quined fabric scraps from her sewing
room floor to make doll clothes. Every
gathering of the women in the family
ultimately involved discussions of
fabric and needlework.” To order EQ4
Simplified, call 1-800-356-4219 or ask
for it in your local store carrying EQ
products.

”Since I am, first and foremost, a quilter, not a
computer expert, I helped my students learn
EQ software the way I learned it myself. Now,
with this Beginner’s Companion to EQ4 you,
like my students, can feel confident enough to
‘try this at home... alone!’ “

More Quilts Featured in EQ4 Simplified:
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From our Mailbox

Where the Wild Things Live

Dear EQ,
There’s been a very large snake hanging
out on our front porch lately (sure, it’s just
a garter snake, but I do NOT like snakes
of any kind whatsoever) so I have not
been opening the front door at all if I can
avoid it! Well, one day last week I hap-
pened to look out the window and noticed
a package on the porch which looked
suspiciously like it might be from you (EQ).
Summoning all my courage, I s-l-o-w-l-y
opened the door a narrow crack, a crack
precisely calculated to be exactly the width
of the box, and gulping hard, stuck my
hand out the door and snatched the box in
so fast that even Mr. Snake would have
been impressed with my speed and agility,
I daresay. Well, it was worth the risk: Sew
Precise Collection 3. I’ve been a major fan
of Shirley Liby since her earliest books,
and this CD is fabulous!! You can piece
together your very own Titanic!!
Thanks so much for another terrific prod-
uct. Keep ‘em coming! I’d brave an en-
counter with an ANACONDA to snatch the
next one off my porch!
- Jane Nehring, Boiling Springs, PA

12-Step Program

Dear EQ,
I was stopped in a restaurant last night by
a friend who had a very serious look on his
face. He told me that, since discovering
quilting a few months ago, his wife no

longer wants to go to parties or out to eat
(I noticed he was alone), doesn’t watch
TV, and turned down a weekend trip on
their sailboat. According to him, all she
wants to do is quilt, quilt, quilt. He asked if
he should be worried. I asked if they had a
computer and he said yes. I asked if she
had Electric Quilt and he said no. I told
him with great enthusiasm that there is a
terrific Internet support group for people
with exactly her problem, and suggested
she call me for information. Did I say the
right thing?
- Carol A. Giannini, Anchorage, AK

Barb Vlack, a quilter and an Electric
Quilt teacher responded to Carol:
Definitely the wife of this friend should be
enrolled in a 12-Step Program for Quilters,
aka The Block of the Month Program.
She’ll learn to live the motto, “Quilting
Forever, Housework Whenever”. She may
even graduate into Fabriholics Anony-
mous, where the 12-Step Program in-
cludes collecting a different color each
month. Support groups for those in need
are popping up all over the place, though
they may be difficult to find in the Yellow
Pages. She should keep an eye to the
newspaper for announcements of commu-
nity events, which often include listings of
quilt shows or quilt guild meetings. She
could even start one of her own with
others of a similar bent. And yes, your
advice about Internet support is right on.
Any moment she doesn’t spend with a
needle in her hand can be spent with a
mouse instead!
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Step 1
Scan a piece of fabric that you want to use in
EQ4. There are too many scanning programs
out there for us to be able to give you more
specific steps. Please refer to your scanner/
image editing program documentation.

Your image must be scanned at 72 dots per
inch (72 dpi or 72 pixels per inch), or they will
appear too large (or too small) on your moni-
tor.

Your image must contain a MAXIMUM of 256
colors. Selecting fewer than 256 colors is OK.

Step 2
Save the fabric image you just scanned as a
windows bitmap file (.bmp). Please refer to
your scanner/image editing program docu-
mentation.

Step 3
Open the file you just created using MS Paint
(it comes with Windows 95/98 and is located
in the Accessories program group).

Optional Step
If you think the fabric pattern looks too large
on the screen, select

Image > Stretch/Skew

Type 50% for both the horizontal and vertical
stretch. This will make the fabric scan appear
smaller. All of the fabrics in the Designer
Fabrics library were resized 50%, so the
fabrics would look better proportioned on your
monitor.

Step 4
Select Image > Attributes...
Your image height and width must be a MAXI-
MUM of 200 each. It can be smaller than 200
by 200.

”Units” must be pixels (may be written “Pels”).

Select “Colors”.

Step 5
Select  File > Save As    and go to your
EQ4 folder (the default location is c:\EQ4, but
yours may be different) and click the “create
new folder” icon.

Easy Steps to Fabric Scanning Success
Tips From Our Scan Man - Bill Clifford

Bill, our new graphics and computer pro, scanned hundreds of fabrics from
13 different fabric manufacturers for our Designer Fabric library. We invited
him to share some of his expert tips with you.
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Step 6
Name the folder you just created “fabrics”
(without the quotes)

Step 7
Open the folder you just created.

Step 8
Give your fabric a name. Make sure that the
name ends with “.bmp” (without the quotes).

Step 9
Make sure that your file type reads “256 Color
Bitmap (*.bmp; *.dib)”

Step 10
Click the Save button. You can now exit MS
Paint, if you wish.

Step 11
Start EQ4 and create a new project. We’re
only going to use this project for importing
fabrics, so name it “Fabrics” or something else
that you’ll remember.

Step 12
Open the EQ4 Sketchbook to the Fabrics tab
and click the clear button to remove all of the
fabrics currently in the sketchbook.

Step 13
Select Libraries > Fabric Library

Step 14
See steps 1-5 on page 100 of the EQ4 Design
Cookbook to put your new fabric scan in the
Sketchbook.

Step 15
See steps 1-8 on page 54 of the EQ4 Design
Cookbook to save your new fabric scan in a
fabric library.

Now, whenever you want to use the fabrics
you scanned, you’ll be able to get them from
the library and they’ll be available to all of your
projects.

You can now use this project (“Fabrics”) to
import other scanned fabrics.

More Successful Scanning Tips:

You DO NOT have to change your monitor
settings to import scanned fabrics into EQ4.

EQ4 will not successfully import bitmaps that
are saved with Run Length Encoding (RLE). If
your image editing program allows for RLE,
make sure that you have chosen NOT to use
it. If you use Photoshop or Paint Shop Pro to
save your images, see this page on our Web
site for more information.

Delete fabrics from the sketchbook that you do
not want to use in your current project.

The largest image size you can use is 200 by
200 pixels. This refers to your image size only
and NOT your monitor resolution.

Easy Steps to Fabric Scanning Success
Tips From Our Scan Man - Bill Clifford

Continued

http://www.electricquilt.com/tech/faqeq53.shtml
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ClubEQ  is a club any EQ user on the Web
can join. clubEQ is a free online EQ user
group with monthly challenges and dis-
plays. Barb Vlack  issues a monthly chal-
lenge theme, offering examples to stimu-
late creative juices.

The challenge is announced each month
on the Info-EQ maillist and on the clubEQ
web page. Everyone has until the 25th of
the month to respond. Users of EQ4 are
welcome to send file attachments via
e-mail to Penny@electricquilt.com. No
sewing is involved. All quilts and fabrics
are virtual. No white gloves necessary!

The clubEQ idea came about because
Barb hosts an EQ users club in

”The Elephant’s Child” by Suzanne Sanger

(An example of the quilts you can find in clubEQ’s gallery)

Woodstock, Illinois. She had described
challenges her club was using, and how
they met monthly to share designs. Many
Info-EQ maillist members worldwide read
about Barb’s club, wanted to participate in
similar challenges, but could not find local
groups.

The monthly challenge quilts since Janu-
ary are now on the site.

All instructions for participating in the
monthly challenge of clubEQ  are on this
page. In addition, anyone may take the
monthly challenges of clubEQ  and use
them in their own EQ club. The challenges
are a fun way to learn more about EQ4!
Visit clubEQ and join the fun!

ClubEQ meets in Cyberspace
by Barb Vlack

http://www.electricquilt.com/clubeq/index.shtml
mailto:penny@electricquilt.com
http://www.electricquilt.com/clubeq/index.shtml
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Since we introduced the
Electric Quilt 4, EQ has been
one busy mouse. We hope he
answers some of your
questions on the following two
pages. For more frequently
asked questions, see “Tech
Support” on our Web site.

Rotating on Layers 2 & 3

Q: How can I rotate a block on layers 2 or 3? I
made the Amish quilt following the recipe in the
cookbook (p. 156). I decided to add on by placing a
stencil block on Layer 3, but it is a square. How can
I make my stencil an on-point square so it matches
the quilt center?
A: When working on layers 2 or 3 on any quilt
layout (or layer 1 on a Country Set Quilt) it is
extremely helpful to use two different tools. The first
is the Graph Pad located at the bottom of the
screen under the quilt tabs. If you do not see the
Graph Pad, click on View in the main menu and
click on Graph Pad. Second, you must use the
Adjust tool. With the Adjust tool selected and the
Graph Pad showing, click on the stencil block (a
frame will surround it). On the Graph Pad there is a
circle made with an arrow that is not closed, it
represents the rotation of the block. To the right of
the circle is the degree to which the block is rotated
and to the right of that number are arrow buttons to
change the degree. Click on the right-arrow button
until you get to 45. Notice your block has rotated to
a perfect on-point square!

Using Sew Precise and BlockBase Blocks in
EQ4

Q: How can I use Sew Precise and BlockBase
blocks in EQ4?
A: If you own other Electric Quilt products:
BlockBase, Sew Precise Collections 1&2, Sew
Precise Collection 3 Shirley Liby Designs, you can
choose to have all the blocks from these programs
appear in the Block Library of EQ4. This requires
that you run the installation a second time to link
these files to EQ4.

IMPORTANT:  Be certain to choose the same
destination folder the second time you run the setup
as you do the first time. (In other words, be sure
you know where you put the other program on your
computer. You need the correct “address” or EQ4
can’t find the block files.)

1. Put the EQ4 CD in the drive and follow the
installation instructions, as if you were reinstalling
EQ4 just as you installed it the first time. But this
time, when you get the Setup Options dialog,
choose “Link EQ4 to other EQ programs.”
2. Choose the products you have installed on your
computer and the location of the files. (Remember:
you need to tell EQ4 the correct location or this link
will not work.)
3. When you have completed the installation a
second time, start EQ4. If you receive the mes-
sage, “EQ4\RES\DEFAULT1.PJ4 contains an
invalid path.” this means that the second time you
ran the installation, you did not choose the same
destination folder as you did the first time. Run the
installation program again choosing the same path
as the original installation.
4. After you have successfully completed the setup
to link the programs, open the EQ4 Block Library.
You will see the other EQ products listed.
5. Double-click on the book to open the files and
then open the pages to see the blocks. These
blocks do not appear in their original fabric color-
ings. They appear in random solid colors ready for
you to use in EQ4.

NOTE: If the book appears with the product name
but does not open when you double-click on it, then
you need run the setup again making sure that you
choose the correct location (path) to the files.

Corrupt Library Files

Q: I get the message “Library Files are corrupted.”
What should I do?
A: If you receive the message, “Library file data is
corrupt.” after linking EQ4 to BlockBase, it means
that EQ4 is having difficulty reading the BlockBase
files. To correct this, do the following, following
either the Quick Steps, or Detailed Steps.

Ask EQ (Page 1):

http://www.electricquilt.com/em-tech.shtml
http://www.electricquilt.com/em-tech.shtml
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Quick Steps:
1. Find the LIB folder inside the BB1 folder.
2. Rename the folder LIBB.
3. Then create a new folder giving it the original
name of LIB.
4. Copy all of the files from the LIBB folder into the
LIB folder. That’s it. You’re done.

Detailed Steps:
Use these steps (which show you each step
needed in order to do the Quick Steps) if you do not
understand how to do the Quick Steps above.
1. Close EQ4 if you have it open.
2. At the Windows desktop, double-click on My
Computer.
3. Double-click on the C: drive. A new window will
open showing all the folders on the C drive.
4. Find the BB1 folder and double-click on it. A
window will open showing all the files and folders
inside the BB1 folder. You should see a folder
called LIB.
5. Click once on the LIB folder to select it. A high-
light will appear behind the letters LIB.
6. Click on File on the main menu bar of this
window.
7. Choose Rename. This will put a rectangular box
surrounding the letters LIB indicating you are in
“edit mode.”
8. Type the name LIBB. Now the folder is renamed.
You need to copy the files that are inside this folder.
9. Double-click on the LIBB folder. A window will
open showing all the files inside the folder.
10. Click on Edit on this window’s main menu bar.
11. Click Select All. You will see all the names of
the files become highlighted.
12. Click on Edit on the main menu bar.
13. Click Copy. You won’t see anything happening,
but all the files have been copied to the Window’s
clipboard (a place for temporary storage).
14. Close this window by clicking on the X in the
upper right corner of the window. (Don’t close My
Computer - so on some computers you may need

to click the Up Folder icon or the Back Arrow button
rather than clicking the X.) Now you will be looking
at the BB1 window again. You should see BB1 on
the title bar of the window.
15. Click on File on the main menu bar of this
window.
16. Point to New and choose Folder. A new folder
will appear. If you don’t see it right away, you may
need to make the window bigger or use the scroll
bar to scroll the view so you can see it.
17. When you find the new folder, it will be high-
lighted and in edit mode ready to be renamed. The
current name will be NEW FOLDER. (If it is not
highlighted with the rectangular box around it
indicating edit mode, click on the folder to select it
and choose Rename from the File menu.)
18. Name this new folder LIB.
19. Double-click on the new LIB folder to open it. A
new window will appear. There are no files in the
folder yet so the window is empty.
20. Click on Edit on the main menu bar of this
window.
21. Click on Paste. The files you copied in step # 13
will be pasted into the folder.
22. Click on the X in the upper right corner of this
window and all other windows open in the back-
ground until you are back to the Windows desktop.
23. Start EQ4.
24. Click on Libraries on the main menu - click on
Block Library. You should no longer see any error
message. When you click on the BlockBase book,
20 books should appear.

Color Search

Q: I’ve used a certain blue in my quilt. How can I
find that blue again in the palette?
A: Do a color search. Here’s how:
1. With a colored block or quilt on the worktable,
click on the Spraycan tool.
2. Click on a colored patch in the block or quilt.
3. EQ4 will find that color or fabric in the Fabrics &
Colors palette.

Ask EQ (Page 1):
Continued
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Deleting Blocks

Q: How do I delete a block from my quilt?
A: Choose Undo from the EDIT menu immediately
after setting the block. Or, just set a new block over
the block you want replaced. Specifically, you can
use the Plain Block tool and set a white block to
replace the unwanted block.

Q: How do I delete a block from layer 2 or 3, or a
Country Set quilt?
A: Choose Undo from the EDIT menu immediately
after setting the block. Or use the Adjust tool.

1. Click on the Adjust tool.
2. Click on the Block you want to delete. It will
become selected.
3. Press the Delete key on your keyboard.

Reusing Country Sets

Q: Can I use one of my Country Set quilts as a
“model” to set new blocks into?
A: Yes. Get your Country Set quilt showing up on
the worktable. With the Set tool selected, set a new
block to replace the old block by selecting a new
block in the palette, then clicking on the center of
the block you want to replace. The new block will
pop into the old block’s space, replacing it. Con-
tinue replacing blocks until you have your new quilt
as you like.

Thread Color

Q: How do I change thread color on my quilt?
A: You can change thread color on an applique
motif (changing the color around the applique motif,
as if the applique was sewn on with colored thread)
in layer 2 or a quilting stencil in layer 3.

Here’s how to change the thread color:
1. Have your applique motif on layer 2, or your
quilting stencil on layer 3.
2. Have the layer 2 tab or the layer 3 tab selected,
depending on which layer you are working on.
3. Click on the Thread Color tool. The Fabrics &
Colors palette appears.
4. Click on the palette to select a color.

5. Click on the applique motif or the quilting stencil
(on the quilt). The thread color changes to your
selected color.

To change color on all motifs or stencils at once,
hold down the CTRL key as you click in step #5.

Country Set

Q: How do I set and rotate blocks or change quilt
block size in a Country Set quilt?
A: Use the Graph Pad.

1. Have a Country Set layout on the worktable.
2. On the VIEW menu, click to put a check in front
of Graph pad. You’ll see a gray toolbar pop onto the
bottom of your screen. Drag the mouse on your
quilt to set a block.
3. Click on the Adjust tool.
4. Click on the block you want to adjust. The Graph
Pad will “come alive,” showing you numbers. These
numbers show you the size, rotation, and position
(on the quilt) of the selected block.

The Graph Pad is used to make fine adjustments to
blocks on layers 2 and 3 and to blocks on layer 1 of
a Country Set quilt. The Graph Pad updates
automatically when you adjust the selected block
with the mouse. When you change one of the
controls on the Graph Pad, the corresponding
position, dimension, or property of the selected
block is adjusted to the new value.

For full, illustrated, information on using the Graph
Pad, see the EQ4 Help files:
In EQ4, on the HELP menu, choose EQ4 Help.
Double-click on Designing a Quilt.
Double-click on Designing a Country Set Layout.
Open and read these two topics:
1. Using the Graph Pad on a single block.
2. Using the Graph Pad on multiple blocks at once.

Deleting Projects

Q: How do I delete a project?
A: You can delete projects from the Win 95/98
Desktop, or from inside EQ4. From your Win 95/98
Desktop you can delete one, or many, projects:

Ask EQ (Page 2):
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1. Double-click on My Computer.
2. Double-click on C: drive (or the drive on which
you installed EQ4).
3. Double-click on the EQ4 folder.
4. Double-click on the PRJ folder.
5. Click on the project you want to delete. (Or, hold
down your keyboard CTRL key as you click on
project after project.)
6. On the FILE menu, choose Delete. You will be
asked if you are sure you want to send the
project(s) to the Recycle bin.
7. Click on Yes.

From EQ4 you can delete one project at a time.

1. On the FILE menu, choose Open.
2. Click the folder in the bottom-left marked “Click
here to open a project not listed above.” This takes
you to where you can navigate through Windows
files.
3. Click on the project you want to delete, to
highlight it.
4. Press your keyboard Delete key. You will be
asked if you are sure you want to send the project
to the Recycle bin.
5. Click on Yes.

New Fabrics

Q: Is there going to be any way to add new fabric
lines to the program?
A: Yes. We will be producing EQ4 Fabric CDs as
accessories for EQ4. These CDs will contain
thousands of new fabrics to update the fabrics
currently on the EQ4 CD. Watch our Web site and
the next issue of the Floppy Gazette for more
information.

Pieced Sashes

Q: How can I make pieced sashes?
A: You can set any block from the Block Library into
a sash space in your quilt layout. The square block
will stretch to become a rectangle and fill your sash.
Tip: Try blocks from the Classic Pieced - Simple

Blocks style. You can also draw your own pieced
sash. To do this, change the drawing square into a
rectangle, and draw the block the same proportion
as your sash.

1. First, set up your quilt layout, noting your sash
dimensions. You will know the width = the width you
set for the sash on the Layout tab. You can figure
out the length by noting the horizontal size of the
block on the Layout tab.
2. Next, see the EQ4 Design Cookbook recipe
“Drawing a Rectangular Block” on page 66. Draw
your block and save it in the Sketchbook.
3. Set your sash block into your quilt layout. The
block will be square (and look odd) in the Sketch-
book, but will look fine when you set it into your
rectangular sash space.
4. To print the block, or templates for the block,
click on the Select tool, click the sash, choose FILE
- Print - Print Block (or Templates).

Making an Apple Core

Q: How do I change an apple block into an “apple
core” as shown on page 77 of the Design Cook-
book?
A: Get the block from the library (Contemporary
Applique - Garden Blocks). Open the Sketchbook,
click on the Apple block, click on the Edit button.
Your apple will now be on the PatchDraw work-
table. To change the apple to an apple core, you
cave in the apple sides:

1. Click on the Bezier Edit tool.
2. Click one side of the apple. The line will become
selected and you’ll see handles. You can now
change the curvature of this selected line between
the two nodes.
3. Drag the handles to make the apple side con-
cave, so it looks like the picture on page 77.
4. Repeat steps #2 and #3 to cave in the other side
of the apple. You’ll now have an apple core block.
Click the Save in Sketchbook button.

Ask EQ (Page 2):
Continued
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Our Talented Users Show and Tell
Quilt Festival in Houston
Lynne Harrill’s Suburban Nights quilt won Second Place
in the small traditional pieced quilts category at the IQA
show at Quilt Festival in Houston, October 1998. And
Lynne even credited EQ3 on her artist’s statement,
which was displayed with her quilt. Thanks and con-
gratulations, Lynne! Lynne is from Cantonment, Florida.
Peggy’s Texas 2 Step
Peggy Raley, the major mover behind the Boerne
[Texas] Quiltfest each year, had three EQ quilts fea-
tured in Texas Hwy magazine. Peggy’s Texas 2 Step,
and Phone Home, were shown hanging in the Boerne
library, and her Amish Shadow with an Attitude made
the magazine’s back cover. Peggy writes: “I would
probably be 60 quilts behind if I had to rely on ordinary
patterns and pencil and paper.”
Computer Chic in New Zealand
Mary Metcalf, from Auckland, New Zealand, featured
EQ3 in an article she wrote for New Zealand Quilter
magazine (issue #24). Mary’s article,
“Computer Chic,” was illustrated with
her quilt Pohutukawa III, which used
different sizes of blocks to create
leaves and blossoms.
Quilting Today
Margaret Gray , from Salem Utah,
turned a BlockBase block into a
bonanza of a prize-winner! Margaret
writes, “Issue 72 of Quilting Today
will have my version of Katherine
Wheels. I took the pattern from BlockBase into EQ. This
was real easy to make, but looks difficult. I still do not
know why this quilt is a big hit. I did enter it in 3 county
fairs and received 5 blue and grand champion ribbons.
[!] It was made as a gift for my husband, and soon it will
go on the bed.”
Gloria Driscoll , from Richford, New York, writes, “My
great-grandmother and I are featured in Quilting Today
(January 1999 issue) about connecting past quilters
with today’s quilters. The quilt shown is from our
extensive collection of quilts made by our foremothers
from the 1850s through 1956. Even though I didn’t use
EQ to make my quilt featured in this article, I now use it
to reproduce these quilts both full size and miniature.
We also used BlockBase to help us date the blocks and
quilts, which helped us to identify the makers. I don’t
believe that we would have been able to do this project
without EQ.”

Contemporary Quilt ’99 Exhibition
Vikki Chenette , from Buffalo, Wyoming, has EQ
designed quilts included in the Contemporary Quilt ’99
exhibition, sponsored by the Wyoming Arts Council in
the Council Gallery, Cheyenne, Wyoming. The show’s
up from July 12 - Sept. 20, 1999. New England Quilt
Museum
Martha Supnik , the New England Quilt Museum’s
Library Volunteer and Webmaster, writes, “Just thought
you’d be pleased to know that the Massachusetts Quilt
Documentation Project has been revived and we are
using a copy of BlockBase on my laptop to find the right
page in Barbara Brackman’s book to verify quilt pattern
names. It’s the fastest way to find them!” The New
England Quilt Museum is in Lowell, Massachusetts.
1999 American Quilter’s Society
Nancy Welsch  used EQ to design the applique central
medallion of the Ole Miss Sesquicentennial Quilt,
displayed at the 1999 American Quilter’s Society show.
Says Nancy, “ All those S’es. The University of Missis-
sippi Sesquicentennial. I said I wished it was Ohio. DH
[Dear Husband] said be glad it’s not the Massachusetts
Institute of Technology.”
Quilt Guild Challenge
Carol Miller, from Clifton, Virginia, told us about her
guild challenge, designed using BlockBase and EQ
blocks. “They are provided with the blocks that existed
at the turn of the last century and told to interpret one or
more as we go into the next century.” Carol is also her
guild’s Webmaster, so if you want to see the blocks and
challenge rules, go to http://www.vcq.org/
century_challenge.htm Carol says you are welcome to
copy it and use it in your guilds.
Vote for a Quilt Design Using EQ
Kay Bruce , from Milano, Texas, told us how her guild
used EQ to “vote” for a raffle quilt design. “When your
guild is trying to decide what raffle quilt to make, print
out about four possible design choices from EQ de-
signs. Take these four printouts to the guild for them to
vote on. Each member writes her initials on her favorite.
The one with the most initials is the popular choice for
the raffle quilt design.”
Basic Realities Contest Winner
Anita Solomon , New York, NY,
won an honorable mention in
the Jinny Beyer Basic Realities
Contest for her EQ-designed
quilt, Reality Check. Below is a
detail from Anita’s prize-winning
quilt.

http://www.vcq.org/century_challenge.htm
http://www.vcq.org/century_challenge.htm
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Recognizing EQ Designers:
page 1 of 2

Introducing EQ4 Block Designers Rita
Denenberg and Debbie Sichel

The answer:  Rita Denenberg and Debbie Sichel
The question:  What two designers have blocks in
the EQ4 Block Library?
Rita Denenberg and Debbie Sichel both contributed
their original block designs to enhance EQ4. We
thought you might like to know a bit more about
these designers, and how they came to design the
blocks you can now see and use in the block
library.

Rita Denenberg:

We first “met” Rita on-line, when she won an EQ
Web site quilt contest with her applique floral quilt,
To Martin with Love, designed on EQ3.

[The blocks from this quilt are in the block library’s
Contemporary Applique, “Rita Denenberg Garden”
file in EQ4. See her quilt, and an interview with Rita,
on the old EQ Web site: http://www.wcnet.org/
ElectricQuiltCo/cont6.htm (web page no longer
exists)]

We soon learned that Rita, from Wellington, Florida,
had won many quilt contests, had quilts featured in
the books Making Childhood Memories, Great
American Quilts, Award Winning Quilts and Their
Makers, and Florida Quilts. Her winning EQ quilt
had even been featured in McCall’s Quilting’s
February 1996 issue.

Rita generously offered to share more block
designs in EQ4, sending us new flower blocks,
Christmas, Hanukkah, Easter and Halloween
blocks. You’ll even find her own self-portrait as a
quilter! This block was possible because Rita was
the first person to test out EQ4’s new importing
feature which lets you trace around a photo (or

drawing) to draw a new block.

To see EQ4 patterns Rita has for sale, including
State Flowers, State Birds, Boy Scouts, and Girl
Scouts, go to http://myquilts.hypermart.net/
patterns.htm

Debbie Sichel:

Debbie Sichel from Coarsegold, California, sent us
an amazing file of Hebrew alphabet foundation
designs last year.

[Find Debbie’s foundation blocks in the Paper
Piecing, Hebrew Alphabet file; plus a Dreidel and
two Groggers in the Holiday Foundations. The
Contemporary Pieced style has 4 Star of Davids in
the Home Delights file.]

We’d had requests for Jewish-themed blocks, so
asked permission to include them in EQ4. She told
us a bit about why she’d designed them.

”The alephbet is what is used to write the Hebrew
language. Hebrew is the language used in Israel,
and in synagogues everywhere used in worship on
the Sabbath. Lots of Jewish art work includes
writing in Hebrew,” Debbie says. “I wanted to be
able to use the letters without always having to
resort to applique, especially if I wanted rather
small letters. I designed the alephbet mainly to give
myself paper foundations for a quilt for Hanukkah.
That quilt is still an electric one! Then I expanded
from those four letters and made enough to make
Yom Kippur in Hebrew for another quilt, expressing
my feelings about the Day of Atonement. From
there I thought it would be fun to make a baby quilt
with the whole alephbet on it.”

Thanks to Rita and Debbie for sharing their EQ
designs with all of us!

http://myquilts.hypermart.net/patterns.htm
http://myquilts.hypermart.net/patterns.htm
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EQ staff member, Margaret Okuley, could
hardly keep the secret! But her news is
out: her shop, The Quilt Foundry in
Maumee Ohio, is one of ten stores fea-
tured in the next Quilt Sampler issue of
American Patchwork & Quilting magazine.
The special annual issue samples the top
quilt stores in North America.

Margaret is EQ’s “resident quilt expert” on
Tuesdays and Fridays. But the rest of the
week she and her three partners run a
busy and popular quilt shop in an historic
town along the Maumee River.

Meet Margaret and her partners when the
magazine comes out May 25, 1999. Mar-
garet used EQ to turn the Pine Tree block,
her shop logo, into a beautiful “September
Song” Pine Tree medallion quilt.
Margaret’s shop will offer kits for her quilt.
Ordering details will be given in the article.

”We think the article will make more
people aware of our store,” says Margaret.
“We already have people stopping on their
way to or from vacation, and we expect
more people to find us this summer.”

Recognizing EQ Designers:
page 2 of 2

American Patchwork & Quilting Honors Margaret

So if you’re driving through Northwest
Ohio sometime soon, plan a stop at the
charming brick building housing The Quilt
Foundry, and say hello to Margaret.

The Quilt Foundry is located at:
234 West Wayne Street
Maumee, OH 43537
Open Monday - Saturday 10am - 4pm &
Tuesday evenings from 7pm - 9pm
Phone: 419-893-5703
Web site: www.quiltfoundry.com

www.quiltfoundry.com
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Make Quilt Block Boxes

Sara Harder , from
Bloomington, Minnesota
impressed us when she sent
some beautiful origami boxes
she made using fabrics and
block patterns from EQ4.
These boxes are a festive
way to give presents (al-
though we think the boxes
are presents in themselves).

Here are Sara’s box instructions (Sara credits the
book Calligraphy Crafts  by Mei-Lan Hom and
Mary Worthington for these directions):

1. Start with a square piece of text-weight paper,
gift-wrap, or fabric bonded to paper. Boxes can be
made any size. But the bigger the box, the heavier
the materials need to be. To figure the size square
needed, double the diagonal of the finished box you
desire. (Sarah used square quilt layouts and printed
them out about 7 inches square.)
2. As with all origami, be as precise as possible.
Cut and fold carefully creasing all folds well!
3. Draw two diagonal lines on the wrong side of the
square to be folded. This locates the center.
4. Fold one corner to the center and then fold over
again to the diagonal line. Unfold. Do all four
corners, one at a time.
5. To make the corners, pleat the middle square on
each side. Place the thumb and forefinger along the
sides of the pleat line. Place the other forefinger on
the other side of the paper and push it up at the
pleat line into the thumb and forefinger. Crease the
pleat line.
6. To assemble, fold two opposite corners into the
center, folding the two sides up. Fold the two
remaining corners into the box.
7. Use a dab of glue to hold the points down in the
lid of the box. A sticker can be used too.
8. To make the bottom, start with a square ¼ - ½
inch smaller than the lid square. This will vary
according to the thickness of the paper, especially if
you have bonded paper or fabric to another paper.

9. Have four sheets of paper ready. When #2 box
doesn’t fit with #1, make #3 to fit it. Then with your
last sheet, make a match for #2. This way there is
no waste, instead, two boxes!

Making Fabric Computer Wallpaper

Pat Tribbey , from North Lauderdale, Florida and
the Webmaster for clubEQ had to let us know about
a recent discovery with the new Electric Quilt 4. We
thought we’d share it with you - hope you like this
innovative idea!.

Other Uses For EQ4 :
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All those gorgeous fabrics in EQ4!

I just experimented with the Electric Quilt 4 and
made wallpaper for my computer desktop with one
of the Designer Fabrics.

Here’s how you can do it:

1. In EQ4, on the WORKTABLE menu, click Work
on Block.
2. On the BLOCK menu point to New Block, click
on PatchDraw.
3. Click the Save in Sketchbook button. EQ4 will
ask if you are sure you want to save a plain block.
4. Click Yes.
5. Click on the Color tab.
6. Color the plain block with any fabric that you
desire.
7. Click the Export Snapshot button. Nothing will
happen. Your cursor will look like a magnifying
glass with a crosshair in the center.
8. Click, hold, and drag the cursor from the top-left
of the block to the bottom-right. (You do not have to
enclose the whole block - in fact, it will make the
wallpaper smaller in memory size if you just en-
close part of it.)
9. Release the mouse. You will see an Export
Snapshot pop-up menu appear.
10. Click the Save as bitmap file button. You can
export it to the Windows directory, but it doesn’t
really matter which directory you put it in. I created
a sub-directory I call Wallpaper in which I put all my
wallpaper files. Name the block, and remember
what you called it and where you exported it.
11. Click Save.
12. Minimize EQ4 so you’re back on the Windows
desktop.
13. Right-click anywhere on the Windows desktop.
14. Click Properties. You’ll see tabs.
15. Click the Background tab showing.
16. Click the Browse button. Navigate to find the
.bmp file you just exported and saved.
17. Double-click on the .bmp file.

18. Click Stretch and then click Apply.
There ya go... a designer fabric desktop!

Quilt tip from EQ’s Shipping Manager

Our shipping manager, Jan Nelson , is also a
quilter. Recently, Jan told us a neat trick that she
uses when she is piecing blocks together, so we
thought we’d share it with all of you. Thanks Jan!

Here’s how to turn a pizza box into a portable
flannel board for patchwork designing.

1. Get an extra large pizza box (usually 14 to 16
inches square).
2. Open the box, and measure the inside bottom.
3. Cut a piece of flannel to fit inside the box (where
the pizza usually sits). Flannel makes a great
surface for holding block pieces in place while
you’re designing because most fabrics “stick” to this
fuzzy foundation.
4. “Piece” your block design together on the flannel
in the pizza box.
5. When you’re done working, close the box lid and
your block is safe from kids and cats, or can be
easily transported to a guild meeting.

[We here at EQ must admit that the reason we
printed this tip for our users was not purely selfless.
Instead, we hope to alleviate some complaints from
your non-quilting family members. Let us explain.
Since the release of EQ4 we’ve received many
messages that you, our users, have been so
engrossed in our products that you’ve forgotten to
cook dinner (we won’t even mention cleaning,
washing, etc.) for those more needy family mem-
bers. Therefore, we thought this tip would be a
great trick for you AND would help you keep your
families fed!]

Other Uses For EQ4 :
Continued
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Web Sightings:

A preview of EQ4 Simplified:
http://www.flash.net/~qltcnfig/

The club EQ website:
http://members.aol.com/anotherpat/clubeq.html

Rita Denenberg’s Patterns for sale:
http://myquilts.hypermart.net/patterns.htm

Shows or Demos in The Netherlands:
http://www.quilt.nl/demo.htm

Virtual EQ3 or 4 Round Robbin:
http://members.aol.com/SangerSL/robinsnest.html

Downloadable Projects and Links to EQ Users:
http://home.sol.no/~sskjonbe/quiltny.htm (web page no longer exists)

http://www.flash.net/~qltcnfig/
http://members.aol.com/anotherpat/clubeq.html
http://myquilts.hypermart.net/patterns.htm
http://www.quilt.nl/demo.htm
http://members.aol.com/SangerSL/robinsnest.html

